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. . 354 Index 359 Contents 6 Supervisor's Guide Contents Maximizing Your Information Resources preface 8 Supervisor's Guide Overview Information,
services, and solutions The Business Objects business intelligence solution is supported by thousands of pages of documentation, available from the products,
on the Internet, on CD, and by extensive online help systems and multimedia. Packed with in-depth technical information, business examples, and advice on
troubleshooting and best practices, this comprehensive documentation set provides concrete solutions to your business problems. Business Objects also offers
a complete range of support and services to help maximize the return on your business intelligence investment. See in the following sections how Business
Objects can help you plan for and successfully meet your specific technical support, education, and consulting requirements. Maximizing Your Information
Resources Supervisor's Guide 9 Information resources Whatever your Business Objects profile, we can help you quickly access the documentation and other
information you need. Where do I start? Below are a few suggested starting points; there is a summary of useful web addresses on page 12. ! Documentation
Roadmap The Documentation Roadmap references all Business Objects guides and multimedia, and lets you see at a glance what information is available,
from where, and in what format. View or download the Business Objects Documentation Roadmap at www.
businessobjects.com/services/documentation.htm ! Documentation from the products You can access electronic documentation at any time from the product
you are using.
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Online help, multimedia, and guides in Adobe PDF format are available from the product Help menus. ! Documentation on the web The full electronic
documentation set is available to customers with a valid maintenance agreement on the Online Customer Support (OCS) website at www.
businessobjects.com/services/support.htm ! Buy printed documentation You can order printed documentation through your local sales office, or from the
online Business Objects Documentation Supply Store at www.businessobjects.com/services/documentation.
htm ! Search the Documentation CD Search across the entire documentation set on the Business Objects Documentation CD shipped with our products. This
CD brings together the full set of documentation, plus tips, tricks, multimedia tutorials, and demo materials. Order the Documentation CD online, from the
Business Objects Documentation Supply Store, or from your local sales office. Information resources 10 Supervisor's Guide ! Multimedia Are you new to
Business Objects? Are you upgrading from a previous release or expanding, for example, from our desktop to our web solution? Try one of our multimedia
quick tours or Getting Started tutorials. All are available via the Online Customer Support (OCS) website or on the Documentation CD. How can I get the
most recent documentation? You can get our most up-to-date documentation via the web. Regularly check the sites listed below for the latest documentation,
samples, and tips. ! Tips & Tricks Open to everyone, this is a regularly updated source of creative solutions to any number of business questions. You can
even contribute by sending us your own tips. www.
businessobjects.com/forms/tipsandtricks_login.asp ! Product documentation We regularly update and expand our documentation and multimedia offerings.
With a valid maintenance agreement, you can get the latest documentation in seven languages on the Online Customer Support (OCS) website. ! Developer
Suite Online Developer Suite Online provides documentation, samples, and tips to those customers with a valid maintenance agreement and a Developer Suite
license via the Online Customer Support (OCS) website. Send us your feedback Do you have a suggestion on how we can improve our documentation? Is
there something you particularly like or have found useful? Drop us a line, and we will do our best to ensure that your suggestion is included in the next
release of our documentation: documentation@businessobjects.com NOTE If your issue concerns a Business Objects product and not the documentation,
please contact our Customer Support experts. For information about Customer Support visit: www.businessobjects.com/services/support.
htm Maximizing Your Information Resources Supervisor's Guide 11 Services A global network of Business Objects technology experts provides customer
support, education, and consulting to ensure maximum business intelligence benefit to your business. How we can support you? Business Objects offers
customer support plans to best suit the size and requirements of your deployment. We operate three global customer support centers: · Americas: San Jose,
California and Atlanta, Georgia · Europe: Maidenhead, United Kingdom · Asia: Tokyo, Japan and Sydney, Australia ! Online Customer Support Our
Customer Support website is open to all direct customers with a current maintenance agreement, and provides the most up-to-date Business Objects product
and technical information. You can log, update, and track caventions used in this guide are described in the table below. Convention This font Some code #
more code Indicates Code, SQL syntax, computer programs.
For example: @Select(Country\Country Id) Placed at the end of a line of code, the symbol (#) indicates that the next line should be entered continuously with
no carriage return. Maximizing Your Information Resources Introduction 1 chapter 16 Supervisor's Guide Overview What is Supervisor? Supervisor is the
product you need in order to set up and maintain a secure environment for Business Objects products. It provides you with a powerful and easy-to-use
structure for distributing information to be shared by all users. This information is centralized through relational data accounts called repositories. It is with
Supervisor that you create the Business Objects repository.
You then define users and user groups, and assign profiles to users. User profiles include user identification (user name and password), the products and
modules they can work with, the universes they can access, and the documents that they can share. You can control user access to Business Objects products,
and manage the exchange and distribution of the universes and documents of all users. Supervisor can run only in client/server mode. Its use requires a
connection to a relational database. Any operation you perform with Supervisor is stored in the repository you are working with. NOTE More than one
administrator working on the same repository resources at the same time from different desks can interfere with one another's work without this being
immediately noticeable to them. We recommend that the same resources should not be granted to multiple supervisors without careful coordination of their
work. Introduction Supervisor's Guide 17 Where to start with Supervisor The first time you launch Supervisor, you launch the Administration Setup wizard.
This user-friendly tool helps you create the repository needed to define users and groups and to share resources.
When you create the repository, a general supervisor is automatically created as the first user. As general supervisor you then create a series of supervisors
who are to define the various user profiles, in addition to a second, "backup" general supervisor for security purposes. Users are then granted access to
repository domains via a special key file that contains the address of the repository they are to work with. Where to start with Supervisor 18 Supervisor's
Guide User profiles Supervisor offers several standard profiles for the various types of users of Business Objects products. The user profile determines by
default what products a user can use: · General Supervisor (all products) · Supervisor (all products) · Designer (all products but Supervisor and Supervisor
over the Web) · Supervisor-Designer (all products) · User (all products but Designer, Supervisor, and Supervisor over the Web) · Versatile (configurable) You
can customize these profiles to reflect the needs of the users. In this way, the role of each user in a user group will be clearly adapted to the actual position the
person holds in your company. General supervisor The general supervisor is the senior system administrator. Using Supervisor, the general supervisor can: ·
create repositories · create any type of user, including other general supervisors · create user groups · administer user accounts and privileges for repository
users · import and export universes to and from the repository · use any feature of all Business Objects products · define a Broadcast Agent for a group ·
launch a Broadcast Agent from the Broadcast Agent Administrator · use Supervisor over the Web · add, delete, and edit OLAP data sources Supervisor The
supervisor is responsible for user administration.
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The supervisor can: · create users with any profile except general supervisor · create user groups · administer user accounts and privileges for repository
users · import and export universes to and from the repository · use Supervisor over the Web Introduction Supervisor's Guide 19 By default, the supervisor
can use any feature of all Business Objects products except Designer, but may be restricted in order to limit the ways in which he or she can manage users or
resources. Designer The universe designer uses Designer to create and maintain universes for a particular group of users.
A universe designer can distribute a universe as a file through the file system, or by exporting it to a repository. Supervisor-Designer A supervisor-designer
creates user profiles, user groups, and universes. This user has all the rights of the supervisor and the universe designer combined. A supervisor-designer can
use Supervisor, Supervisor over the Web, and Designer, as well as the Business Objects end-user products (InfoView, BusinessObjects and WebIntelligence).
User Users use the Business Objects end-user products to view, query, report and analyze data.
They may also use the optional REPORTER and Explorer modules for multidimensional analysis. End users can produce documents containing data from one
or more data sources. Versatile A versatile user is a customized user who may be given access by a supervisor to any combination of Business Objects
products. We recommend that you not create a versatile user with rights only to BusinessQuery. BusinessQuery users should also have rights to
BusinessObjects.
User profiles 20 Supervisor's Guide Resources The resources that can be managed and controlled by Supervisor fall into the following categories: · Business
Objects products · Universes · Documents · Repository domains · Stored procedures Products The supervisor can grant or deny access to these Business
Objects products: BusinessObjects, Supervisor, Designer, BusinessQuery and WebIntelligence. WebIntelligence access is granted to users of InfoView, which
provides the core functionality of WebIntelligence, whether or not they also use the optional WebIntelligence modules, Reporter and Explorer. Universes A
universe is the semantic layer that isolates the end user from the technical issues of the database structure. It lets you work with data in terms you can easily
understand. With Supervisor, you can manage universes created by the designer(s), and you can authorize users and user groups to access one or more
universes. As the supervisor, you can also define certain security levels within the universes based on the user type. For example, you can set restrictions on a
class or object, and define other parameters pertaining to the components in universes. You can also redefine certain critical parameters such as the address
of the connection to the RDBMS. Documents Supervisor lets you manage the assignment of documents or shared templates. You can also authorize specific
users to update both the data and formats of these documents.
Supervisor lets you manage categories, which are properties that end-users can assign documents they send to users, groups or the Broadcast Agent. You can
also authorize specific users to manage categories. While general supervisors can manage categories without restriction, supervisors and authorized users
can manage only the categories they create. Introduction Supervisor's Guide 21 Repositories With Supervisor, you set up the structure for distributing
information which is to be shared by all users. This information is centralized through relational data accounts called repositories. When you launch
Supervisor the first time, you use the Administration Setup Wizard to create a repository with a general supervisor. You can then use the Wizard to create
other repositories as well. For each repository, you can create a series of supervisors who are authorized to create users and to define their access to the
repository's domains and resources. Users who belong to more than one repository choose which one they want to work with at login. We recommend that
you work with a single repository as a matter of general practice.
Multiple repositories should only be used by supervisors managing several sites or by very advanced users. For more information on the structure of the
repository, refer to The repository domains on page 23. Stored procedures A stored procedure is a combination of SQL statements that are translated,
optimized, and stored in executable form on certain SQL servers. End users can execute stored procedures on the universes assigned to them by the
supervisor. The resource called "stored procedure" in Supervisor is the secured connection to the database account that stores the procedure.
After creating that connection, you assign it as a stored procedure to a user or group. It is then visible in Supervisor as a stored procedure. Resources 22
Supervisor's Guide User hierarchy and resource access The role and the relationship of the supervisor with respect to other BusinessObjects and InfoView
users and resources are depicted in the diagram below. General Supervisor defines Supervisor identifies and manages creates and manages Universe
Designer creates query End Users create repository universes BusinessObjects or WebIntelligence documents The general supervisor defines the supervisor
and creates the necessary structure (the data accounts on which the repository resides) for the purposes of resource-sharing. The general supervisor also
ensures the security of access to the different products.
The supervisor also creates user groups and defines user profiles such as the universe designer and end users. The universe designer creates universes from
which end users can query data and create documents. Introduction Supervisor's Guide 23 The repository domains A Business Objects repository is a set of
data structures stored on a database. A repository makes it possible to share the resources necessary for a distributed architecture. To ensure security and
manage user resources, a repository comprises three types of domains: · a security domain, which contains the definition of the other domains as well as the
definition of users · universe domains, which are meta-models of related databases, containing a description of the data to be accessed · document domains,
which contain the structures for storing shared documents and for executing tasks according to a timestamped definition. These three types of domains make it
possible for all users to share resources. Security Reference Universes Documents Although a general supervisor can create additional domains, two domains
of the same type cannot be located in the same data account. You create repositories with the Administration Setup wizard, as explained in Installing the
Repository on page 27.
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The repository domains 24 Supervisor's Guide The security domain The security domain is a set of data structures created with the Administration Setup
wizard whenever a repository is created (see , "Installing the Repository" on page 27). Each domain of a repository is identified in its security domain.
When a domain is created, its reference is automatically stored in the security domain. The security domain also contains information on the identification of
the users, and on the management of the different products. The address of the security domain must be recognized by all workstations using Business Objects
products in client/server mode, so that all users can communicate with the other domains of the repository in a transparent manner. This address is contained
in the key file, which is created at the same time as the security domain, and which must be distributed to all authorized users. Security Domain Key file
(*.key) references Universes Documents Each time you create a domain, Supervisor automatically updates the repository. The universe domain The universe
domain is a set of data structures containing universes created with Designer. In order for a universe to be shared, it must be exported to the universe domain
by the designer or supervisor. When you create a repository using the Administration Setup wizard and the "Default installation" option, a universe domain is
created automatically at the same time as the security and document domains. The wizard can be started by the Repository command on the Tools menu or the
Admin button of the Supervisor login window.
Introduction Supervisor's Guide 25 The document domain The document domain is a set of data structures containing documents. Documents stored in the
document domain can include those created by end users with Business Objects products, or any other file format. In order to share documents or cause them
to be refreshed during scheduled processing, end users must send them to the document domain. To submit documents for scheduled processing, end users
send them to the Broadcast Agent. Documents submitted for scheduled processing can be monitored by the administrator from the Broadcast Agent console.
For more information, refer to the Broadcast Agent Administrator's Guide. When you create a repository using the Administration Setup wizard and the
"Default installation" option, a document domain is created automatically at the same time as the security and universe domains. The wizard is launched the
first time you launch Supervisor and can also be started by the Repository command on the Tools menu or the Admin button of the Supervisor login window.
The repository domains 26 Supervisor's Guide Supervisor over the Web Supervisor over the Web allows you to manage users and groups via a web browser.
You create a Business Objects repository using Supervisor, and the repository containing the security domain.
Then you use either Supervisor or Supervisor over the Web to define users and user groups, assign profiles to users, and edit their properties in the security
domain. Supervisor over the Web runs in 3-tier architecture in a JSP environment. It requires an application server and a Business Objects server with a
connection to the relational database that hosts the repository. NOTE More than one administrator working on the same repository resources at the same
time from different desks can interfere with one another's work without this being immediately noticeable to them. The same resources should not be granted
to multiple supervisors without careful coordination of their work. What can you do with Supervisor over the Web? Supervisor over the Web offers the
following abilities: · managing groups - you can create, move, delete, and rename groups · managing users - you can create, rename, and delete users, assign
and remove them from groups, change passwords, and edit user properties · managing many users at the same time - you can edit add, remove, and delete
multiple users, and edit the properties for a selection of users. All changes performed in the Supervisor over the Web are immediately taken into account in
the repository and in the Administration Server cache. Who can use Supervisor over the Web? Any user authorized to access Supervisor can access
Supervisor over the Web. This includes users with the following profiles: · General Supervisor · Supervisor · Supervisor-Designer · Versatile with Supervisor
rights To install, configure, and use Supervisor over the Web, refer to the Supervisor's Guide: Supervisor over the Web. Introduction Installing the Repository
2 chapter 28 Supervisor's Guide Overview Supervisor runs in client/server mode.
Before you can successfully start a Supervisor session, the following must be installed on the client and server workstations: On the server: · an RDBMS, on
which the repository resides · an SQL communication driver · a data communication protocol On the client workstation: · a data communication protocol · an
SQL communication driver · Supervisor The client and the server can be located on the same computer. BusinessObjects SQL Driver Network SQL Driver
RDBMS Client Workstation Server For information on the database configuration and network protocols, refer to the section in the Data Access Guide that
corresponds to your RDBMS. Installing the Repository Supervisor's Guide 29 Choosing a setup configuration The Administration Setup wizard is
automatically started when you launch Supervisor for the first time. The wizard allows you to set up a repository necessary for resource-sharing quickly and
efficiently. During subsequent logins, you can start the wizard by clicking Admin in the Supervisor login window if you want to create another repository. To
launch Supervisor: 1. Select Start, Programs, BusinessObjects, Supervisor. You can also launch Supervisor by entering Supervsr.exe in the Run command
line. The User Identification dialog box appears.
Choosing a setup configuration 30 Supervisor's Guide 2. Click Admin. You can also start the Administration Setup wizard by entering the user name
GENERAL and the password SUPERVISOR, and clicking OK. The Welcome dialog box appears. The Welcome dialog box displays an overview of the main
steps that you will perform with the wizard.
Installing the Repository Supervisor's Guide 31 3. Click Begin to start the wizard. The Choose Setup Configuration dialog box appears. The Choose Setup
Configuration dialog box prompts you to select one of the following installation options: · Run a default installation (recommended): Automatically creates
the three repository domains--security, universe and document--on the same data account. This is the option most frequently used.
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· Run a custom installation: Allows you to distribute all repository domains in the database environments of your choice. This type of installation requires
extensive knowledge of your database environment, and should only be selected if you want to manage several versions of your resources simultaneously. For
more information, see Running a custom installation on page 41. · Run a safe recovery: Allows you to perform a recovery installation. This is necessary in the
following situations: - The location of the security domain has been modified. - One of the parameters in the connection string of the security domain, such as
the user name or password, has been changed. - The key file of the repository you want to work with has been inadvertently moved, renamed or damaged. For
more information on safe recovery, see Running a recovery installation on page 46. Choosing a setup configuration 32 Supervisor's Guide Running a default
installation The default installation comprises four successive steps in which you: · define the general supervisor · define a connection to the repository · build
the repository structures · distribute repository access to users Defining the general supervisor In this step, you identify the general supervisor. 1.
Select the option Run a default installation, and click Next. The Define the General Supervisor dialog box appears. 2. Enter your name, password, the
confirmation of your password, and the name of your company. In this example the XYZCompany is given as the company name. The company name you enter
becomes the first user group created and appears as the root group in the Supervisor interface. The user name and password you enter are the ones you will
use each time you wish to log into Supervisor as the general supervisor. 3. Click Next. The Define the Repository Connection dialog box appears.
Installing the Repository Supervisor's Guide 33 Defining the connection to the repository In this step, you create a connection to the database in which the
wizard is to create the repository. At any time after installation, you can run the wizard from the Supervisor main window in order to redefine the repository
connection of document and universe domains. For information on how to do this, refer to Managing the repository on page 144. 1. Click Setup.
The New Connection Wizard appears. Running a default installation 34 Supervisor's Guide 2. Click Next. The Database Middleware Selection dialog box
appears. 3.
From the tree select the driver for your connection, then click Next The Login Parameters dialog box appears. 4. Select the type of connection from the Type
list. 5. In the Connection Name text box, type the name of the connection. Installing the Repository Supervisor's Guide 35 6. Enter the user name, password,
and datasource name for the security repository. Click Next. The Perform a test dialog box appears. NOTE Characters entered in the password field are
displayed as asterisks.
To avoid making typing errors in the Password field, type the password in the User Name field; select it; press Ctrl-X to cut; then in the password field press
Ctrl-V to paste. 7. Click Test Data Source. Any errors appear in the scroll box in the dialog box. If the test is not successful, check the information in the
Login Parameters dialog box for correctness. 8. If the test is successful, click Next. The Advanced Parameters dialog box appears. For information on setting
the parameters in this dialog box, see the Data Access Guide. 9.
Click Next. The Custom Parameters dialog box appears. For information on setting the parameters in this dialog box, see the Data Access Guide. 10. Click
Finish.
The Build the Repository dialog box appears. Running a default installation 36 Supervisor's Guide Building the repository The Build the Repository dialog
box informs you that the wizard is ready to create the repository. 1. Click Next to start building the repository. Once the creation process has begun, you
cannot interrupt it.
When the script has finished processing, the following dialog box appears. If an error occurs during the creation of the repository, a dialog box appears
informing you of the cause of the error. Installing the Repository Supervisor's Guide 37 2. Save the SQL script which created the repository by clicking Save
As, and specifying the location where the SQL script is to be stored. The SQL script contains useful structural information on the repository. We recommend
you save the script in a safe location. 3. Click Next. The Repository Access dialog box appears. Running a default installation 38 Supervisor's Guide Defining
repository access The Repository Access dialog box is where you specify where to create the key file and what to name it.
The key file contains the address of the repository's security domain. All users of Business Objects products who will be using this repository must therefore
have access to the key file. The wizard suggests an option based on the deployment method and installation folder selected during installation. The option you
select determines how users will access the repository. 1. Select an option. - Create the file in a default shared folder on the network. The folder displayed is
the shared folder defined during installation. In deployments using a shared key file, all Desktop and Administration Products should specify the same shared
folder at installation. See the Installation and Configuration for Windows guide for a list of Desktop and Administration Products.
Choose this option to allow users of Desktop and Administration Products to connect to the repository through a single access point on the network. - Create
the file locally on your machine. Choose this option to allow users of Desktop and Administration Products to connect to the repository directly from their
own machines. If you choose this option you must distribute this key file to users of Desktop and Administration Products. 2.
If you want to name your key file something other than the default name, bomain.key, enter the name. Click Next. Once the file is copied, a message
confirming the creation of the key file and the general supervisor appears. NOTE WebIntelligence works only with key files named "bomain.
key" in lower-case letters. Choose this name if your deployment includes WebIntelligence. Installing the Repository Supervisor's Guide 39 3. Click Finish to
quit the wizard. A dialog box appears advising you to create a second general supervisor. This is important since if at any time you forget the general
supervisor's password, or you enter the password incorrectly three times in a row, you will no longer be able to access Supervisor as a general supervisor.
You are therefore strongly advised to create a second "backup" general supervisor. For more information, refer to Creating a second general supervisor on
page 65.
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4. Click OK to clear the Supervisor message.
The main window of Supervisor appears (see The Supervisor main window on page 52). Running a default installation 40 Supervisor's Guide Distributing the
key file Distribute the key file according to the option you chose in the Repository Access step of the Administration Setup Wizard. ! For users of desktop and
administration products Users of Desktop Products and Administration Products (BusinessObjects, Supervisor, Designer, BusinessQuery) can access the
repository either through a single, shared point of access on the network, or from their own machines. To do so they must have the necessary middleware and
network permissions. Shared folder (ShData) If, to create the key file, you chose the "shared folder" option in the Repository Access step of the Administration
Setup Wizard, you must make sure all users of Desktop and Administration Products have access to that folder in the network. Local folder If, to create the
key file, you chose the "LocData subfolder" option in the Repository Access step of the Administration Setup Wizard, you must send a copy of the key file to
each user, or make it available on the network for them to copy, with instructions to store it in the following local folder: \\<installation
folder>\BusinessObjects 5.1\LocData\ \\<Windows profile folder>\Application Data\Business Objects\Business Objects 6.0\MyLocData\ where <Windows
profile folder> is, for example, C:\Documents and Settings\<user name>. ! Server products Users of Server Products, i.e.
InfoView, WebIntelligence, Broadcast Agent, and 3-tier BusinessObjects, access the repository via the Business Objects server. You must log in as an
administrator to the Business Objects server machine and store a copy of the key file in the locData folder whose location was defined at installation and
configuration. By default its location is: \\<installation folder>\BusinessObjects Enterprise 6\locData\ where <installation folder> is the location chosen at
installation to store the Business Objects program files. If you modify the location of the security domain, you must re-create the key file and distribute it as
described above. For more information, refer to Running a recovery installation on page 46.
Installing the Repository Supervisor's Guide 41 Running a custom installation A custom installation allows you to distribute all repository domains in the
database environments of your choice. This type of installation requires extensive knowledge of your database environment, and should only be selected in
special situations (for example, if you want to manage several versions of your resources simultaneously). Running a custom installation is the only way you
can manage different universes with the same name within the same repository. To perform a custom installation, proceed as follows: 1. Follow the
procedures described in Choosing a setup configuration on page 29.
2. Select the Run a custom installation option from the Choose Setup Configuration dialog box. Before you can create other repository domains, you must first
create the security domain. To create a domain, you need the following rights on your target database: - read/write access - the right to create tables, insert
rows, create the index, create comments on system tables, and delete tables 3. Create the security domain. These steps are the same as those for the default
installation (see Running a default installation on page 32). Once you have created the security domain and the key file is distributed to your users, you can
create any other domain with the next three steps: - defining a connection to the domain - building the domain - viewing the domains created Running a
custom installation 42 Supervisor's Guide You can create the other domains as described below. Regardless of the domain type (such as universe or
document), the procedure is always the same. Once the general supervisor, the key file, and the security domain are created, the Repository Access dialog box
prompts you to create another domain, or to quit the wizard. 4.
To create another repository domain, click Next. The Define the Repository Domain dialog box appears. Installing the Repository Supervisor's Guide 43
Defining the connection to a new repository domain You create the new repository domain in the database to which you are connected. To do so, you must
first select the Select the network layer from the drop-down list box. 1. Click Setup. 2. In the Setup dialog box, enter the user name, password, and pathname
of the database to be opened and in which the domain is to be created. Depending on the driver you selected, the parameters of this dialog box vary. For more
information on this dialog box, refer to the section in the Data Access Guide that applies to your RDBMS.
3. Enter the name of the domain, and select a domain type from the drop-down list box. 4. Click Next. The Build the Repository dialog box appears.
Running a custom installation 44 Supervisor's Guide Building the repository domain This dialog box informs you that the wizard is ready to create the new
domain. 1. Click Next to begin the process. During the process, the SQL script which is used to create the repository domain is scrolled rapidly in a pane
within the dialog box. If no errors occurred during the execution of the script, a message confirms the successful execution.
If an error occurs during the creation of the repository, a message appears informing you of the cause of the error. 2. Click Next to display the result of the
execution. Installing the Repository Supervisor's Guide 45 Viewing the domains created The list of repository domains created appears in the final dialog box.
This list contains the name of the domain, its status, and its type. The status field indicates whether the domain was created successfully (OK) or not (Error).
3. If you want to create a new domain, click Next. For more information, refer to Defining the connection to a new repository domain on page 43. 4.
Click Finish to quit the wizard. The main window of Supervisor appears (see The Supervisor main window on page 52). Running a custom installation 46
Supervisor's Guide Running a recovery installation You may need to perform a recovery installation in the following situations: · The location of the security
domain has been changed. · One of the parameters in the connection string, such as the user name or password, has been changed. · The key file has
inadvertently been moved, renamed or damaged. In any of these situations, you can perform a recovery installation as follows: 1. Follow the procedures
described in Choosing a setup configuration on page 29. 2. Select Run a Safe recovery from the Choose Setup Configuration dialog box, and then click Next.
The New Connection Wizard appears.
3. Click Next. The Database Middleware Selection dialog box appears.
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4. From the tree select the driver for your connection, then click Next The Login Parameters dialog box appears.
5. Select the type of connection from the Type list. 6. In the Connection Name text box, type the name of the connection. 7.
Enter the user name, password, and datasource name for the database. Click Next. The Perform a test dialog box appears. 8. Click Test Data Source. Any
errors appear in the scroll box in the dialog box. If the test is not successful, check the information in the Login Parameters dialog box for correctness. 9. If
the test is successful, click Next. The Advanced Parameters dialog box appears.
For information on setting the parameters in this dialog box, see the Data Access Guide. 10. Click Next. The Custom Parameters dialog box appears. For
information on setting the parameters in this dialog box, see the Data Access Guide. 11. Click Finish. 12. Select the physical location in which the key file is
to be created in one of the Installing the Repository Supervisor's Guide 47 following: - the shared folder defined at installation and configuration - the local
data folder You can also enter the name of the key file if you do not want to use the default name, bomain.key.
NOTE WebIntelligence works only with key files named "bomain.key" in lower-case letters. Choose this name if your deployment includes WebIntelligence.
Once the file is copied, a message appears confirming that the key file was created. To ensure that Business Objects users have access to the key file, see
Distributing the key file on page 40.
13. Click Finish to quit the wizard. The User Identification dialog box appears. 14. Log into Supervisor by entering the same identification (user name and
password) you entered previously with the wizard.
The main window of Supervisor appears. Running a recovery installation 48 Supervisor's Guide Installing the Repository Basic Procedures 3 chapter 50
Supervisor's Guide Overview This chapter shows you how to perform some basic tasks the first time you use Supervisor, and should help you to quickly
acquire the main principles of user administration. Once you master the basics of using Supervisor, you will be ready for the more detailed information
provided in the later chapters. You should follow each of the procedures in order, so that you can check the results you obtain with the tests provided at the
end of the chapter. The procedures are repeated and subsequently enhanced by further, increasingly complex actions. NOTE If you enter the same values as
those used in the examples in this chapter, you should be aware that Supervisor inserts these values into the security domain tables of the repository you are
logged in to. You may want to start by creating a test repository in which to do these practice exercises. To do so, see Installing the Repository on page 27.
Basic Procedures Supervisor's Guide 51 Starting Supervisor When you installed the repository, you defined the user name and password of the first general
supervisor (see Choosing a setup configuration on page 29). You will now use these to launch your first Supervisor session.
1. To launch Supervisor select Start, Programs, BusinessObjects, Supervisor or enter Supervsr.exe in the Run command line. The User Identification dialog
box appears. 2. In the User Name text box, enter the name you chose when you ran the installation (see Defining the general supervisor on page 32). By
default, the last user name entered is already displayed in the User Name text box. 3. In the Password text box, enter the password you chose during
installation. Depending on your database, user names and passwords may be casesensitive.
4. If there is more than one repository, choose which one you want to work with by choosing its Security Domain (this is the name of the repository's key file).
5. Click OK. After a few seconds, the Supervisor main window appears.
NOTE It is not possible to have two Supervisor sessions running at the same time on the same machine. Starting Supervisor 52 Supervisor's Guide The
Supervisor main window The Supervisor main window comprises the following: · the title bar, which displays the name of the application followed by your
user name and, if you have more than one repository, the name of the repository's key file · the menu bar · the toolbar · the User pane, which lists the
hierarchy of users and user groups created in the security domain of the repository · the Resource pane, with five tabs for viewing and assigning resources
title bar menu toolbar the User pane lists all users and user groups the Resource pane lists tabs for assigning resources Basic Procedures Supervisor's Guide
53 Refresh versus Regenerate When you work in Supervisor, you make changes to the repository that are reflected in your local cache. If other supervisors
are also making changes to the same repository, their changes are reflected in their local cache. However their changes do not appear automatically in your
display or local cache. To update your display and cache in Supervisor, you have two options in the View menu: · Refresh · Regenerate What does Refresh
do? When you select View > Refresh or F5, your local display and cache are updated with your changes to the repository.
You do not see any changes made to the repository by other supervisors. What does Regenerate do? When you select View > Regenerate, or Ctrl + F5, your
local display and cache are updated with all of the changes made to the repository since you logged in. It is important to regenerate before creating anything
new, for example, users, groups, universes, and domains, to be sure you have an up-to-the-minute view of the repository. Refresh versus Regenerate 54
Supervisor's Guide Creating user groups The User pane is the area in which you manage all users and user groups. The root group in the User pane
represents the organization (such as a corporation, company or bank for which you will set up user administration. This is the name you entered as the
"company name" when you built the repository using the wizard (see Installing the Repository on page 27). Any operation resulting in the creation of a group
or user is automatically recorded in the security domain of the repository. When you installed the repository, you created the root group. We'll assume you
called it XYZCompany as suggested in the previous chapter for performing these exercises. All groups you subsequently create will belong to this root group.
Group names are unique within the repository. No two groups may have the same name. Creating the first group The first time you start Supervisor, the root
group (XYZ company) is selected. To create the first group: 1. Do one of the following: - select User, New, Group - click New Group. The group symbol, a
folder, appears immediately in the User pane under the New Group root group level.
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2. In the name label, enter the name Finance, and press the Enter key on your keyboard. The Finance group is now displayed in the User pane. Creating the
second group To create a second group in the root group: 1.
Click the XYZ Company root group. 2. Click New Group. The group symbol appears. New Group 3.
In the name label of the group, enter the name Human Resources, and press the Enter key on your keyboard. The Human Resources group is now displayed in
the User pane. Basic Procedures Supervisor's Guide 55 Creating a subgroup To create a subgroup within the Human Resources group: 1. Make sure that
Human Resources is still selected. 2.
Click New Group. 3. In the name label, enter the name Payroll, and press the Enter key on your New Group keyboard. The Payroll subgroup appears within
the Human Resources group. In addition, you can define properties for groups and subgroups from the Group Properties dialog box. This procedure is
described in Managing user groups on page 97. Creating user groups 56 Supervisor's Guide Creating users You created the general supervisor when you ran
the wizard. You can create additional users as described below. User names are unique within the repository. No two users may have the same name.
However, the same user can belong to more than one group and appear in each in the User Pane. These are considered as different instances of a single user.
Creating the first user To create a user belonging to the Finance group: 1. Click the Finance group. 2. Do one of the following: - Select User, New, User. Click New User. The new user appears immediately in the User pane. 3. In the name label of the user, enter the name John, and press Enter.
John's default profile is User. This means user John can access only the Business Objects end-user products but not Designer or Supervisor. 4. If it is not
already selected, click the Configuration tab in the Resource pane. In the Resource pane, BusinessObjects is followed by the word Profile, meaning John has
access to BusinessObjects because that is the default setting for his profile.
The products the user cannot access are flagged with a red X: . New User Basic Procedures Supervisor's Guide 57 Assigning a profile to a user To create a
user belonging to the Payroll subgroup, and to assign a new profile to this user: 1. Click the Payroll subgroup. 2. Do one of the following: - Select User, New,
User.
- Click New User. The new user appears immediately in the User pane. 3. In the name label of the user, enter the name Anne, and press Enter. User Anne
appears immediately in the User pane within the Payroll subgroup. By default, her profile is User. Anne can therefore access only the Business Objects enduser products. In the Resource pane, these products are followed by the word Profile. The products this user cannot access are flagged with red X's. To
modify this user profile: 1.
Right-click user Anne. 2. Select the Set Profile To command, and then select the Designer profile. The symbol identifying Anne in the User pane changes to
reflect her new profile. Her access authorizations are modified. By default, a universe designer can access Designer and the Business Objects End-user
products. In the Resource pane, Designer is followed by the word Profile. Supervisor, which a designer cannot access, is flagged with a red X. New User
Creating users 58 Supervisor's Guide Assigning a password to a user You can create a user belonging to a subgroup and assign a new profile and password
to this user. Using the example from the previous section, user Anne should already be selected.
If not click, click user Anne in the Payroll subgroup. 1. Do one of the following: - Select User, New, User. - Click New User. The new user appears
immediately in the User pane.
2. In the name label of the user, enter the name Pat, and press Enter. User Pat appears immediately in the User pane in the Payroll subgroup. By default,
Pat's profile is User. 3.
To change the profile of user Pat from User to Supervisor, right-click the user, and select Set Profile To, Supervisor. The symbol representing user Pat in the
User pane changes to reflect his new profile. His access authorizations are modified. By default, the supervisor has access to Supervisor and to Business
Objects end-user products. In the Resource pane, Supervisor is followed by the word Profile. Designer, which a supervisor cannot access, is flagged with a
red X. 4. To assign a password, double-click Supervisor Pat. The Definition tab of the User Properties dialog box appears. 5.
Enter the password Patty. Depending on your database, passwords may be case-sensitive. If you use any uppercase characters in the password (as in the
example above, Patty), you may need to enter the password in exactly the same way. 6. Confirm the password by entering it in the Confirm Password text box,
and click OK. The dialog box closes. New User Basic Procedures Supervisor's Guide 59 Moving a user If you want to move supervisor Pat from the Payroll
subgroup to the Human Resources group: 1. Click supervisor Pat in the Payroll subgroup. Supervisor Pat is highlighted. 2.
drag supervisor Pat to the Human Resources group (the Human Resources group is correctly selected when you see a box around the text). Pat now belongs
to the Human Resources group. His icon appears on the same level in the tree structure as the Payroll subgroup. Duplicating a user and modifying a user
profile The universe designer of the Payroll subgroup, Anne, can also belong to the Finance group as a User. To duplicate designer Anne in the Finance
group: 1.
Click designer Anne in the Payroll subgroup. Designer Anne is highlighted. 2. While holding down the Ctrl key on your keyboard, drag Designer Anne to the
Finance group. (The Finance group is correctly selected when you see a box around the text.
) Anne appears in both the Payroll and Finance groups with the same profile. 3. To assign a User profile to Anne in the Finance group, right-click user Anne
in the Finance group. 4. Select Set Profile To, User. The symbol identifying Anne in the Finance group changes to reflect her new profile. Her access
authorizations are modified. By default, a User has access only to Business Objects end-user products. In the Resource pane, BusinessObjects is followed by
the word Profile. The products that the user cannot access are flagged with a red X.
You can also move a user via the Add to Group and User Properties dialog boxes. These methods are explained in Managing Users and Groups on page 93.
Creating users 60 Supervisor's Guide Disabling a user If you don't want user Anne to be able to use Business Objects products right away, you can disable
this user. 1. Click user Anne in one of the groups to which she belongs. 2. Do one of the following: - Select User, Disable/Enable. - Click Disable/Enable
User. The symbol for Anne in the User pane appears with a red X. Disable/ Enable User Supervisor automatically disables Anne in the Payroll subgroup and
in the Finance group.

You're reading an excerpt. Click here to read official BUSINESS
OBJECTS SUPERVISOR 6.5 user guide
http://yourpdfguides.com/dref/3796638

Why in both groups? Because although an instance of Anne appears in both groups, they represent a single user. Now Anne can no longer log into any
Business Objects products. Restricting user or group access to commands You can restrict the use of any product by limiting access to certain commands or
menus of its interface. Because some users in your organization may still be using an earlier release, you can manage command restrictions for both the
current and the previous release. This feature is available through the Command Restrictions dialog box, called by double-clicking a Business Objects
product in the Configuration tab or by selecting a product, then selecting Resource, Properties.
See Restricting the use of commands in the interface on page 184 for a full explanation of how to restrict commands for users or groups. Basic Procedures
Supervisor's Guide 61 Controlling rights of supervisors By using the Command Restriction dialog box, you can prevent supervisors you create from having
access to certain commands. For example, you can prevent a supervisor from creating users by setting the status of a secured command. However, all users
inherit the secured command settings of the group they belong to. This means that if the secured command setting does not apply to the supervisor's group, the
supervisor need only create another user in the group, give that user a supervisor profile, and log in as that supervisor to get around the command restriction.
To reliably restrict the rights of a supervisor, therefore, you must set the restriction not on the supervisor but on the group the supervisor belongs to. Proceed
as follows to keep a supervisor from creating new users: 1. In the User pane of Supervisor, select the group the supervisor belongs to. 2. Double-click
Supervisor in the Resource pane. The Command Restriction dialog box appears. Creating users 62 Supervisor's Guide 3. Click the User and Group command
family in the tree on the left, then click Create User in the list on the right. 4. Select Hidden in the Status box.
A grey icon appears next to the command. 5. Click OK to close the dialog box. See Restricting the use of commands in the interface on page 184 for full
information on how to use the Command Restriction dialog box. If a Supervisor applies a command restriction to the group to which he or she belongs, that
restriction applies to the Supervisor as well as the rest of the group. NOTE Only the General Supervisor can then remove the restriction. If you are a
Supervisor, only during the current session will you be able to remove any restrictions you apply to your own group. After you log out, you will not be able to
remove them in future sessions. Basic Procedures Supervisor's Guide 63 Testing your setup This section allows you to test the results you obtained while
working through the procedures in this chapter. If you have followed these procedures step-by-step, you should now have the following results displayed in
the User pane.
Checking user authorizations To check whether you correctly assigned a password to supervisor Pat: 1. Select Tools, Login As. 2. Enter Pat as the user name,
and PASS as the password. 3.
Click OK. An error message appears informing you that the password is not correct. This means that you need to enter the password (Patty) you previously
assigned to Pat. As indicated in the error message, you are allowed only two more attempts to enter the correct password. NOTE Depending on your
database, the user name and password may be casesensitive.
You may need to enter them exactly as they were when the user was created. Testing your setup 64 Supervisor's Guide 4. Click OK. The User Identification
dialog box is re-displayed. 5. Enter Patty as the password. The resulting window contains the title bar with the user name, Pat, and the name of the key file in
parentheses. The User pane displays only the group in which Pat has a supervisor profile (Human Resources). It also shows Payroll, a subgroup of the
Human Resources group. The User menu no longer contains the New, User command, and the New User button does not appear on the toolbar, because you
restricted this command for supervisor Pat.
Basic Procedures Supervisor's Guide 65 Creating a second general supervisor Normally, you should have only one general supervisor to manage and control
all users, user groups, and resources. However, if at any time you forget the general supervisor's password, or you fail to enter the password correctly three
times in a row, then you will no longer be able to access Supervisor as a general supervisor. For this reason, you are strongly advised to create a second
general supervisor soon after installing Supervisor. You should keep this backup general supervisor in reserve and keep secure a separate record of the
password. If you should be unable to log in as the first general supervisor for the reasons described above, you will still be able to log in as the backup
general supervisor. To create a second general supervisor: 1. Log in as the general supervisor. 2. Click the root XYZ Company group. 3.
Click New User on the toolbar. The new user appears in the User pane. 4. In the name label of the user, enter a name (such as "2ndGenSup"), and press
Enter. By default, the new user's profile is User.
You need to modify this profile. 5. Right-click the new user, and select the Set Profile To, General Supervisor. 6. Right-click the new user again, and select
Properties.
The User Properties dialog box appears. 7. Enter and confirm a password in the Definition tab, then click OK. You have now defined your reserve general
supervisor. Be sure to keep a record of the password secure for future reference. NOTE If you do not create a reserve general supervisor, Supervisor will
remind you to do so each time you launch the program! Creating a second general supervisor 66 Supervisor's Guide Creating a group reference profile When
a document is distributed to a group of users using Broadcast Agent (BCA), BCA has to compute the rights of each individual user to filter out restricted data.
This causes a performance problem. When you add a Group Reference profile (GRP) to a user profile, BCA uses the GRP rights to filter out restricted
information for the whole group. This saves time and reduces server activity. If there is no GRP identified, a document cannot be sent to a group.
The GRP profile should have: · a "user" profile · no access to Supervisor or Designer · a disabled login Although the GRP can be applied to an existing user,
it is best to create a specific GRP user for any group that receives batch distribution via BCA. NOTE The primary general supervisor cannot be the GRP.
REMINDER The removal of a GRP impacts the BCA tasks for the whole group. Basic Procedures Supervisor's Guide 67 EXAMPLE Creating a GRP-specific
user 1. Log in as the general supervisor.
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